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A Note to Our Readers

This blog has been created using a combination of  artificial 

intelligence tools and human review to help deliver clear, 

structured, and up-to-date learning content.

All technical topics, examples, and workflows are curated to 

support learning and skill development. While every effort is 

made to ensure accuracy and clarity, readers are 

encouraged to validate concepts through hands-on practice 

and documentation. Our goal is to make learning more 

accessible, efficient, and practical for everyone.

Disclaimer: 
All product names, logos, brands, and registered trademarks 

mentioned in this publication are the property of  their 

respective owners and are used for identification purposes 

only.

— CADIN360 Team
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UNDERSTANDING
THE SOLIDWORKS

START SCREEN



Introduction
When starting to work with SolidWorks, one of the first things you encounter is the start screen.

Understanding the SolidWorks start screen is essential for efficiently navigating the software,

accessing recent files, launching new projects, and customizing your workspace. It can seem

intimidating at first, but with a clear understanding of its features and options, you can streamline

your workflow and improve productivity significantly. In this comprehensive guide, we will explore

every aspect of the SolidWorks start screen, providing actionable insights to help beginners and

seasoned users make the most out of their experience.

What is the SolidWorks start screen?
The SolidWorks start screen appears immediately upon launching the software. It serves as a

hub for managing your projects, opening existing files, creating new documents, and accessing

various settings. Essentially, it acts as a launching pad that allows users to quickly access their

workspace and set up their environment for modeling, simulation, or other tasks.

Understanding how to navigate and customize the SolidWorks start screen can save you time

and reduce frustration, especially when handling complex projects or working in a collaborative

environment.

Components of the SolidWorks start screen
The start screen is composed of several key elements designed to facilitate quick access and

easy navigation. Let’s go over each component in detail:

1. Recent Documents and Files

This section displays your recently opened or edited SolidWorks files. It helps you quickly resume

work without the need to navigate through folders.

• Features:

• List of recent files with thumbnails

• Clear option to remove individual recent files



• Ability to pin frequently used files

2. Templates and New Document Options

Here, you can select templates for various SolidWorks document types, including parts,

assemblies, and drawings.

• Features:

• Predefined templates for different standards

• Custom template options

• Quick access to create new files

3. Launching New Files

The start screen allows you to immediately start a new project by selecting the desired document

type and template, streamlining your workflow.

4. Open Existing Files

You can browse your computer or network drives directly from the start screen to open existing

models, saving time compared to navigating through Windows Explorer.

5. Customization and Settings

Most start screens include quick access to settings and preferences, allowing you to adjust

options like file locations and interface display preferences.

6. Documentation and Tutorials

Some versions provide links to help resources, tutorials, or community forums to assist users in

learning or troubleshooting.

How to navigate the SolidWorks start screen

step-by-step



Getting familiar with the start screen can make your workflow more efficient. Here's a practical,

step-by-step approach to navigating it:

1. Opening the start screen

• When you launch SolidWorks, the start screen appears automatically.

• To reopen it later, go to File > New or select Start SolidWorks from the recent programs.

2. Opening recent files

• Locate the “Recent Documents” section.

• Scroll to find the desired file.

• Double-click the filename or right-click and select Open.

3. Creating a new document

• Choose among the available templates (Part, Assembly, Drawing).

• Select the appropriate template based on your project type.

• Click OK to open a blank workspace.

4. Customizing templates and default files

• Click on Templates to modify or add custom templates.

• Use the Options menu to specify default file locations and settings.

5. Opening files from your drive

• Use the Open button or browse icon.

• Navigate through your folders.

• Select the desired file and click Open.



6. Accessing help and tutorials

• If available, click the links or icons for tutorials, help files, or community forums.

• Use this feature for troubleshooting or learning new features.

Practical tips to make the most of the start screen
• Pin frequently used files: Keep essential projects pinned for quick access.

• Customize templates: Tailor templates to your workflow to save time.

• Organize document locations: Use default folders for different project types.

• Shortcut access: Create shortcuts on the start screen for common tasks.

• Use recent history wisely: Regularly clear or update your recent files list to stay

organized.

Common mistakes to avoid on the SolidWorks start

screen
• Ignoring template customization: Using default templates without personalization can

slow down your process.

• Cluttering recent files: Not clearing old or irrelevant files can make navigation

cumbersome.

• Not backing up settings: Failing to save custom templates and preferences can lead to

repetitive setup.

• Overlooking tutorials: Missing out on learning resources that could improve your skills.

• Relying only on recent files: Avoiding the use of folders and archives can hinder

long-term organization.

Best practices for customizing your start screen



• Set default template options that match your project types.

• Organize your templates and files into folders for easier navigation.

• Use pinned files and folders to keep your most-used resources accessible.

• Configure display settings to match your workflow preferences.

• Create multiple templates for different standards and standards variations.

Comparing the start screen in different SolidWorks

versions
Different SolidWorks versions may feature slight variations in the start screen layout. Here's a

quick comparison:

Feature
SolidWorks

2020

SolidWorks

2023

Recent Files

Section

Yes Yes

Custom

Templates

Yes Yes



Tutorials/Help

Links

Basic links Expanded

resources and

links

Customization

Options

Extensive within

Options menu

Similar, with some

UI improvements

User Interface

Personalization

Limited Enhanced

customization

options

Remember that regardless of the version, understanding your start screen helps streamline your

workflow.

Conclusion
The SolidWorks start screen is a powerful gateway to your 3D modeling projects. By

understanding its components and functionalities, you can save time, organize your work better,

and get started quickly on new and existing files. Customizing the start screen to fit your workflow

enhances productivity and reduces frustration, especially for beginners navigating their first

projects. As you become more familiar with its features, you'll find it an invaluable tool for efficient

design and collaboration.



FAQ

1. How do I customize the SolidWorks start screen?

Ans: You can customize templates, default file locations, and what appears on the start screen

through the Options menu and template management.

2. Can I open multiple files directly from the start screen?

Ans: No, the start screen allows opening recent files or creating new ones, but opening multiple

files simultaneously requires using the Open dialog or Windows Explorer.

3. How do I add frequently used files to the start screen for

quick access?

Ans: Pin the files to the recent list or save them in custom templates and folders for quick access

from the start screen.

4. Is the start screen customizable in all SolidWorks versions?

Ans: The degree of customization varies by version, but most recent versions allow significant

personalization through settings and templates.

5. How do I access tutorials and learning resources from the

start screen?

Ans: Many versions include links or icons for tutorials, help files, and community forums directly

on the start screen or via the help menu.

6. Can I disable the start screen and open SolidWorks directly

into a workspace?

Ans: Yes, you can disable the start screen in the options so that SolidWorks opens directly into a

workspace or a specific template.



7. How do I reset the start screen to default settings?

Ans: Resetting the start screen requires resetting SolidWorks settings or restoring defaults in the

Options menu, but this varies by version.

This in-depth guide aims to ensure you understand and master the SolidWorks start screen,

enabling a smoother and more productive design experience.



About CADIN360

CADIN360 Learning Tutorials is an educational 

platform focused on practical CAD, CAM, and CAE 

learning.

The platform provides clear, industry-oriented 

tutorials, design workflows, and real-world 

insights using tools such as SolidWorks.

CADIN360 is created to help learners, students, 

and professionals build strong fundamentals and 

practical design skills in modern CAD workflows.
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Practice What You’ve Learned

You’ve just completed this blog and learned 

important concepts in SolidWorks.

To help you practice and apply what you’ve 

learned, the next pages include a sample from 

our SolidWorks book .This sample contains 

practice exercises and real-world practice 

tasks designed to strengthen your skills.

© 2026 CADIN360. All Rights Reserved.

What you’ll find next:
 Practice exercises from the book

 A brief  overview of  the complete book

 Options to explore or request the full sample

Your hands-on SolidWorks practice starts next.
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S A C H I D A N A N D  J H A

SOLIDWORKS

ALL IN ONE 

WORKBOOK
500+ PRACTICE EXERCISES

• 2D Sketching • 3D Modeling • Assembly Drawings

https://cadin360.com/?blog_slug=understanding-the-solidworks-start-screen


Dear Reader,

Thank you for choosing the SOLIDWORKS ALL IN ONE WORKBOOK. This book is part of 

the CADIN360° learning series, created to help engineers, students, and professionals 

master SolidWorks through structured and practical exercises.

This book contains over 500 carefully crafted practice drawings, including:

• 200 2D Sketching Exercises

• 200 3D Modeling Exercises

• Comprehensive Assembly Models with 150+ Individual Part Drawings

We founded CADIN360 in 2016 with the goal of delivering practical, high-quality learning 

material for CAD software. More than 9 years later, we’re still committed to producing 

consistently exceptional books. With each of our titles, we’re working hard to set a new 

standard for the industry. From the paper we print on, to the authors we work with, our goal 

is to bring you the best books available.

I hope you see all that reflected in these pages. I’d be very interested to hear your comments 

and get your feedback on how we’re doing. Feel free to let me know what you think about 

this or any other CADIN360 book by sending me an email at cadin360@gmail.com

If you think you’ve found a technical error in this book, please visit  

https://cadin360.com/contact-us/. 

Customer feedback is critical to our efforts at CADIN360.

Best regards,

Sachidanand Jha

Founder & CEO, CADIN360

https://cadin360.com/?blog_slug=understanding-the-solidworks-start-screen
mailto:cadin360@gmail.com
https://cadin360.com/contact-us/?blog_slug=understanding-the-solidworks-start-screen


SOLIDWORKS ALL IN ONE WORKBOOK

Published by CADIN360

Website: cadin360.com

Copyright © 2025 by CADIN360, All rights reserved.

This book is copyrighted and the CADIN360 reserves all rights.

No part of this publication may be reproduced, stored in a retrieval system or transmitted, 

transcribed, stored in retrieval system or translated into any language, in any form or by any 

means, electronic, mechanical, photocopying, recording, scanning or otherwise, without the 

prior written permission of the publisher & Author.

Limit of Liability/Disclaimer of Warranty:
The publisher and the author make no representations or warranties with respect to the 

accuracy or completeness of the contents of this work and specifically disclaim all 

warranties, including without limitation warranties of fitness for a particular purpose. No 

warranty may be created or extended by sales or promotional materials. The advice and 

strategies contained herein may not be suitable for every situation. This work is sold with 

the understanding that the publisher is not engaged in rendering legal, accounting, or other 

professional services. If professional assistance is required, the services of a competent 

professional person should be sought. Neither the publisher nor the author shall be liable 

for damages arising herefrom. The fact that an organization or Web site is referred to in this 

work as a citation and/or a potential source of further information does not mean that the 

author or the publisher endorses the information the organization or Web site may provide 

or recommendations it may make. Further, readers should be aware that Internet Web sites 

listed in this work may have changed or disappeared between when this work was written 

and when it is read.

Examination Copies
Books received as examination copies in any form such as paperback and eBook are for 

review only and may not be made available for the use of the student. These files may not be 

transferred to any other party. Resale of examination copies is prohibited

Electronic Files & Usage Rights:
The electronic file/eBook in any form of this book is licensed to the original user only and 

may not be shared, distributed, resale or transferred to any other party. To access files, the 

user must contact cadin360@gmail.com with valid proof of purchase. Unauthorized 

distribution of the files is a violation of copyright law.

Disclaimer:
All product names, logos, brands, and registered trademarks mentioned in this publication 

are the property of their respective owners and are used for identification purposes only.

https://cadin360.com/?blog_slug=understanding-the-solidworks-start-screen


SOLIDWORKS ALL IN ONE WORKBOOK

 This book contains over 500 CAD practice exercises, organized as:

1. 200 2D Sketching Exercises

2. 200 3D Modeling Exercises

3. Assembly Projects with 150+ Part Drawings

 This book is a practice workbook. It does not include step-by-step tutorials for creating 

2D drawing, 3D models and Assembly.

 SI units (millimeters) are used for all dimensions.

 Third Angle Projection is used throughout this book.

 This book is for SOLDIWORKS and also suitable for Other Feature-Based Modeling 

Software such as Inventor, Catia, Fusion 360, NX, Solid Edge, AutoCAD, PTC Creo etc.

 Designed for students, engineers, drafters, and designers looking for extensive CAD 

practice using SolidWorks.

 The exercises cover a wide range of real-world modeling challenges—from simple 

sketches to complex assemblies—offering clear, concise, and structured drawing 

practice.

 Exercises are organized to gradually develop beginner to advanced-level design skills.

 Each exercise is self-contained, and can be completed independently.

 Assembly drawings follow industry standards to help improve visualization and multi-

part modeling skills.

 All dimensions are in mm. Assume missing dimensions logically.

©Copyright 2025 CADIN360, All rights reserved



HOW TO USE THIS BOOK

This book contains over 500 CAD practice exercises, designed for self-paced learning using 

SOLIDWORKS or any feature-based modeling software.

• 2D Sketching Exercises: Start here if you're a beginner or learning how to use the sketch 

environment.

• 3D Modeling Exercises: Follow after mastering sketching. Practice creating solid models 

using the provided dimensions.

• Assembly Drawings: Use after completing part models to understand multi-part 

assemblies, relationships, and constraints.

Tips for Best Use:

• Complete the exercises in order, or jump to any skill level you prefer.

• All dimensions are in millimeters.

• Where dimensions are missing, apply logic or practice estimation.

• This book is ideal for both students and professionals preparing for industry design work.

Note: 

This book is available in multiple formats – Black & White, Standard Color, and 

Premium Color editions.

Happy learning!
– Team CADIN360

©Copyright 2025 CADIN360, All rights reserved
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EXERCISE-01

01PAGE

https://link.cadin360.com/r/D2i_Fc?blog_slug=understanding-the-solidworks-start-screen
https://link.cadin360.com/r/D2i_Fc?blog_slug=understanding-the-solidworks-start-screen


Get The Complete 

Practice Sample
You downloaded a single Exercise PDF

What you will receive
• A software-specific complete sample PDF

• Multiple real practice exercises (not a single file)

• Same quality as our professional training material

• Compatible with the latest software version

The complete practice sample for this software includes multiple 

exercises and is not available inside this PDF.. 

How to get the complete sample
Click the button below and enter a valid email address.

The complete sample PDF will be delivered automatically
after the form is submitted.

SEND THE COMPLETE SAMPLE TO MY EMAIL

https://link.cadin360.com/r/TMetyQ?blog_slug=understanding-the-solidworks-start-screen


©Copyright 2025 CADIN360, ALL Rights Reserved

Are you a Student, Unemployed or Financially struggling ?
Get this special Bundle only for $19.99

Get the Complete Bundle for Only $27.99

Special Offer for Students & Learners

Special Offer for Only $19.99

END OF SAMPLE

What’s Included in the
SOLIDWORKS ALL IN ONE WORKBOOK?

 Books contains exercises of 
Sketching, 3D Modeling & Assembly.

 500+ Practice Exercises with 
Dimensions

 Full Assembly STEP Files (.stp format) 
– Compatible with all major CAD 
software

 Instant Download Link - Sent to Your 
Email After Payment

 Lifetime Access to All Files

Get the Paperback book on Amazon

https://link.cadin360.com/r/c_VccK?blog_slug=understanding-the-solidworks-start-screen
https://link.cadin360.com/r/c_VccK?blog_slug=understanding-the-solidworks-start-screen
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https://link.cadin360.com/r/4yv_el?blog_slug=understanding-the-solidworks-start-screen
https://link.cadin360.com/r/4yv_el?blog_slug=understanding-the-solidworks-start-screen
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🙏 Thank You for Learning with Us!

Thank you for choosing the SOLIDWORKS ALL IN ONE WORKBOOK. We hope this book 
helped you strengthen your CAD skills through hands-on practice and real-world design 
challenges.
Your feedback means the world to us!
If you found this book helpful, please take a moment to leave a review on the Amazon 
where you purchased it. Your kind words not only motivate us but also help other learners 
discover our resources. Scan the QR.

⭐ A good review goes a long way!

📘 Explore More CAD Practice Books
Looking to continue your learning journey?
We offer similar practice-based books for
over 30 CAD software platforms, including:
• AutoCAD
• Fusion 360
• FreeCAD
• TinkerCAD
• TurboCAD
• Siemens NX
• CATIA
• Creo
• SketchUp and many more...
Visit our website 👉 www.cadin360.com to browse the complete collection.

💬 Stay Connected
Have suggestions, feedback, or just want to say hello?
We’d love to hear from you!
📧 Email: cadin360@gmail.com
🌐 Website: www.cadin360.com

🚀 Keep Practicing. Keep Designing.
Whether you're a beginner or a pro, practice is the key to mastering any CAD software. 
We're honored to be a part of your journey.
Happy Designing!
– Team Cadin360

https://www.cadin360.com/?blog_slug=understanding-the-solidworks-start-screen
http://www.cadin360.com/?blog_slug=understanding-the-solidworks-start-screen



